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Formula 1 is the highest level and most expensive type of motorsport. There are 10
teams on the grid who all have different amounts of money in their bank, depending
on their funding from partners and other companies. However, to make sure that the
racing is fair, Formula 1 introduced a cost cap. This means each team has the same
maximum amount of money that they can spend in a season. If the team goes over
that cost cap, they will be fined.  
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To have a go at sticking to a set amount of money (budget), your task is to design
a car with a maximum budget of £200,000. You need to choose car parts which
would be the best parts for the race in Monaco. 

Look at the ‘Car parts cost sheet’  below which will show you the different car
parts that you need to buy to build a car. You will have the choice of buying basic
or enhanced car parts, but you need to make sure that you don’t spend more than
£200,000 on 5 different parts.  

You can work out the calculations on a calculator, on your computer/phone or
using long addition/subtraction. Make sure you make some notes of your car part
choices so that you can substitute some of the enhanced car parts if you
overspend! 

Once you’ve worked out your total choice of car parts, complete the table on the
‘Car parts cost sheet’. 

Try the activity Digitally    

INSTRUCTIONS
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TIP:  To know which of the enhanced parts might be better to buy than others for
this circuit, be sure to read the facts about Monaco below before you make your
choices.  
Facts about the Monaco circuit: 

It is a race with a track that goes through the streets of Monaco rather than on
a circuit, 
The streets are very narrow, so it is difficult for drivers to overtake, 
There are lots of very tight corners, 
Drivers must change gear 54 times per lap, 
There is a tunnel which drivers must drive through as part of one lap. 
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https://view.genial.ly/65a97d18450d6d0014a4ccd5
https://view.genial.ly/65a97d18450d6d0014a4ccd5
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Did you manage to get the best car made from the best parts for the
Monaco circuit within budget? 
An example of how you could stay in budget is below, but this isn’t the
only right answer: 

LET’S DISCUSS!

COSTS OF A CAR ACTIVITY GUIDE

PART CHOSEN COST REASON OF CHOICE
Upgraded Front

Wing 
£80,000 With Monaco having a lot of tight corners having the

upgraded front wing that gives more downforce, allows the
driver to get around the corners more quickly. 

The fact that the upgraded front wing is narrower than the
basic front wing means that the car is thinner and takes up less

room on the track. This also allows the car to overtake more
easily. 

Basic Rear Wing £50,000 
With the enhanced rear wing being wider, this would be a
disadvantage to the driver as it means the car will take up

more room on the track. 
The advantage of the enhanced rear wing is to allow the car to
go faster on the straight parts of the track, but since there are
more corners than straights on the Monaco circuit, this isn’t

really something that’s needed so the basic rear wing will be a
good choice to have. 

Basic Steering
Wheel

£25,000 As Monaco has a difficult circuit, the driver will need to really
concentrate on driving, so the fact that they have extra

opportunities to talk to their engineers with the enhanced
steering wheel isn’t really needed.  

4 Upgraded
Tyres  

£3,000 x 4 =
£12,000 

With so many corners on the Monaco track, the drivers need
to break a lot to get around the tight corners. Choosing the
more durable tyres means that they will last longer than the

basic tyres would, given all the braking that needs to be done. 

Upgraded Gear
box 

£30,000 Since Monaco has so many corners, the speed that the drivers
execute throughout a race varies a lot as they need to slow

down and speed up a lot.  
Given the fact that the drivers need to change gears 54 times
for each lap in this race, it is best to spend more money on the

enhanced gear box to make it last the whole the race.  

TOTAL £197,000 
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Determine the costs for the Monaco race weekend if one of the drivers crashed and need a
new front wing and gear box, using the example above. Would this be over budget? By how
much? 

Answer: 1) £80,000 + £30,000 = £110,000 of additional cost  
                        2) £110,000 + £197,000 = £307,000 (total spend)  
                        3) £307,000- £200,000= £107, 000  
Therefore, if a driver crashed and needed an additional gear box and front wing, the team
would be £107, 000 over the budget.  

There are 24 races in an F1 season. If the team chose the upgraded tyres (£12,000 per set
of 4), how much would they spend on tyres throughout the whole season? 

Answer: £12,000 x 24= £288,000  

BONUS CHALLENGE
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Parts
required Cost of basic part Cost of upgraded part Benefit of upgraded part

Front wing £60,000 £80,000
A narrower upgraded front wing
gives more downforce which means
the car can corner at faster speeds

Rear wing £50,000 £70,000
Wider rear wing which makes the
car faster on the straight parts of the
track

Steering
wheel £25,000 £50,000

Extra buttons to allow the driver to
communicate better with their
engineer

Tyres (need
4) £2,000 £3,000

The upgrade will allow tyres which
are more durable when lots of
breaking is needed 

Gear box £20,000 £30,000 A much smoother and more durable
gearbox

Car part cost sheet 
Total spend £200,000 

You must have at least one of each of the essential car parts below for your car. The engine is
already included in the team’s budget so will not need to be budgeted for. 



Parts
required Basic or Upgraded Cost of part Reason for choosing 

Front wing

Rear wing

Steering
wheel

Tyres (need
4)

Gear box

PARTS CHOSEN 



A key responsibility of those in finance roles is to monitor the money spent during the
season. At each year's end, they must report to the Senior Management Team on the
total expenditure and any remaining funds from the cost cap.  

MATHS – Addition, Subtraction, Algorithms, Financial Modelling 
TECHNOLOGY – Data Visualization, Analysis 

STEM CONCEPTS:

CONTEXT:
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Your challenge is to see if you can create a presentation to the Senior Management Team of BWT
Alpine F1 Team about the costs that were spent in 2023. 

 
Look at the ‘Costs spent in 2023’ table below which has a breakdown of the money that was
spent over the course of the season. Your task is to work out how much was spent and to see if
there was any money left from the £10,000,000 which was cost cap for 2023. 

INSTRUCTIONS
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ITEM COST 
Staffing Costs £2,500,000 

Team Factory utilities costs
(lighting, heating etc) £500,000 

Parts Logistics (getting the
cars to and from the

races) 

£1,000,000 

Staff travel to and from
the races 

£1,500,000 

Driver Costs £1,000,000 (for each of
the 2 drivers) 

Staff Uniform £500,000 

Car Build Costs £1,000,000 

Machinery Maintenance £500,000 

Contingency (extra money
which was spent but not

budgeted for) 

£300,000 

Please note  these are not the real costs associated with the 2023 season and are
purely for representing data

You then need to decide how you are going to present those figures. You can do so by
creating graphs and pie charts in Microsoft Excel and then putting all your findings into a

Microsoft PowerPoint presentation to show the Senior Leadership team.  

Unsure of how to use Excel or PowerPoint? Consult these guides for tips!  

https://static1.squarespace.com/static/65836673ce386f3ae8740e8b/t/65bab20539aa5b73a3d7fee3/1706734085300/Excel+How+To+Guide.pdf
https://static1.squarespace.com/static/65836673ce386f3ae8740e8b/t/65bab215e55a86743ea0568c/1706734101956/Ppt+How+To+Guide.pdf
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The total spend for the BWT Alpine F1 Team in 2023 was £9,300,000.
This left £700,000 of money under the cost cap which wasn’t spent. 
Were you able to find the answer? If not, go back and look at your work
to see where you might have gone wrong.  

Think about what might be needed in the contingency pot of
£300,000. What could happen in a season for them to need this
much money? 
If the team managed to not spend their £300,000 contingency money
over the next 5 years, how much would they save in total? 

Answer: £1,500,000 

LET’S DISCUSS!

BONUS CHALLENGE

TIP 1: Make sure that you double
check all your calculations
(especially the number of 0s in the
costs) to make sure you don’t make
mistakes.   

TIP 2: Think about how you can
present your findings in an
interesting way that is going to be
easy for the viewers to understand. 

COST CAP CONSIDERATIONS ACTIVITY GUIDE



EXCEL HOW TO GUIDE 

Rows: Horizontal sections represented by number (1,2,3, etc.)  
Columns: Vertical Sections represented by letters (A, B, C, etc.)  
Cell: The intersection of a row and column, represented by a letter followed by a
number (ex. A1, B4)  
Range of Data: A collection of selected cells.  

How to create a chart in Excel:  
Step 1: Select/highlight the range of data you want to summarize in a chart by
clicking in the top left corner of the cells and drag until is all shaded:  

Step 2: On the Insert tab, select the type of chart
you want to create:  

 Step 3: Select the type of graph you
wish you present your data with. 



EXCEL HOW TO GUIDE 
From there, excel will generate a chart of your data!  

You can add in axis titles, a title for your chart, switch the axis’s for different
information, and even create a legend! All of this is available for you in the Chart
menu.    

How to find the mean in Excel:  
There is no formula called MEAN in excel, so we use the average formula.  
1.  Type the ‘=’ sign into a cell, then type “AVERAGE” after the ‘=’ sign  
2. select the cells that you wish to find the mean of.  
3. Once they are selected, hit enter and you will have the mean (or average) of
the numbers! 



POWER POINT HOW TO GUIDE 

Let’s create a presentation on PowerPoint together: 
Open PowerPoint.1.
In the left pane, select New.2.
Select an option:3.

To create a presentation from scratch, select Blank Presentation.a.
To use a prepared design, select one of the templates.b.

Add a slide
In the thumbnails on the left pane, select the slide you want your new slide to follow.1.
In the Home tab, in the Slides section, select New Slide.2.
In the Slides section, select Layout, and then select the layout you want from the menu.3.

Add and format text
Place the cursor inside a text box, and then type something.1.
Select the text, and then select one or more options from the Font section of the Home
tab, such as Font, Increase Font Size, Decrease Font Size, Bold, Italic, Underline, etc.

2.

To create bulleted or numbered lists, select the text, and then select Bullets or
Numbering.

3.

Add a picture, shape, and more
Go to the Insert tab.1.

To add a picture:a.
In the Images section, select Pictures.b.
In the Insert Picture From menu, select the source you want.c.
Browse for the picture you want, select it, and then select Insert.d.

To add illustrations:2.
In the Illustrations section, select Shapes, Icons, 3D Models, SmartArt, or Chart.a.
In the dialog box that opens when you click one of the illustration types, select the
item you want and follow the prompts to insert it.

b.



Whenever there is a Grand Prix weekend, each F1 team needs to send a team of
around 50 staff members who will ensure that the 2 cars and drivers can race. These
people range from the mechanics who build/fix the car, the engineers who work out
the best way for the drivers to win the race (strategy), to the hospitality team who
look after the team and guests plus many more.  
Each of these team members needs to wear team uniform at each race weekend,
throughout the year, to make sure that it’s obvious which team they are part of.
Some of these races are in very hot locations and some in colder places in the world,
so they need to make sure they have uniform for all types of weather.  

MATHS – Addition, Subtraction, Algorithms, Multiplication
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CONTEXT:
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KITTING OUT
THE CREW  
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ACTIVITY GUIDE

‘Team kit costs sheet’ 
‘Team Kit Options sheet’ 
Calculator 
Computer (optional) 

EQUIPMENT NEEDED



Your challenge is to work out how much budget would be needed from the BWT
Alpine F1 team for the 2024 season in terms of the amount of team kit that’s
needed.  

Look at the ‘Team kit costs sheet’ which shows which items of clothing are on offer
for the team to order. You have a choice of footwear to choose from and 3
different layers of clothing to pick – a base, mid and top layer.  

You will need to stay below £7000 for the entire group of 50 people attending
the races.  

Try out the activity digitally: Here

INSTRUCTIONS
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TIP 1:  
Make sure that you double
check all your calculations,
especially when
multiplying them by 50 for
the number of team
members in the team. 

KITTING  OUT THE CREW ACTIVITY GUIDE

TIP 2:  
Think carefully about
making sure that the team
will have a suitable item of
clothing for warmer days
and colder days.  

Look at some of the suggested options on the ‘Team Kit Options sheet’ which
considers the need of a mixture of thin and thick clothing to cover all weathers. 

Why don’t you have a go at budgeting for option B for the team kit – still ensuring
that you have an item of clothing for the different layers and a pair of trainers –
and see which one costs more money. 
Present the two budget options in a way that would be suitable for a meeting with
the BWT Alpine F1 Senior Management team. This could be done by using
Microsoft PowerPoint or Excel.  
If the team needed 3 sets of your chosen uniform for one season, how much
would that cost? 

The answer dependents on their solution. It should be their total multiplied by
3. 

LET’S DISCUSS!

BONUS CHALLENGE

https://view.genial.ly/65a8181a1a2e6500138e6300/interactive-content-kit-considerations


Final Team Kit choice 1:
 Total spend = £5750

Layers Clothing choice Cost per item Total cost for 50 

Base layer Thin round neck £5 £250

Mid-layer Thick hoody £30 £1,500

Top layer Thin rain jacket £50 £2,500

Footwear Lightweight trainers £30 £1,500

Final Team Kit choice 2: 
Total spend = £6,500

Layers Clothing choice Cost per item Total cost for 50 

Base layer Thick polo shirt £10 £500

Mid-layer Thin ¾ zip jumper £20 £1,000

Top layer Thick puffer jacket £60 £3,000

Footwear Heavyweight trainers £40 £2,000

Team kit choice options
Below are a few examples of how the team kit could be chosen which takes into account needing
a mixture of thin and thick clothing to cover all weathers. 
Please note that this is isn’t every possibility, just a few.

KITTING  OUT THE CREW ACTIVITY GUIDE



Layers Clothing choice Cost per item Total cost for 50 

Base layer Thin round neck £5 £250

Mid-layer Thick body warmer £45 £2,250

Top layer Thin rain jacket £50 £2,500

Footwear Heavyweight trainers £40 £2,000

Final Team Kit choice 3:
Total spend = £7,000

KITTING  OUT THE CREW ACTIVITY GUIDE



Item Cost Per Item 

Base Layer Items 

Thin round neck T-shirt £5

Thick polo shirt £10

Mid Layer Items 

Thin ¾ zip jumper £20

Thick hoody £30

Top Layer Items 

Thin body warmer £35

Thick body warmer £45

Thick puffer jacket £60

Thin rain jacket £50

Footwear 

Lightweight trainers £30

Heavyweight trainers £40

Each of the 50 members of the team needs to have
one T-shirt (base layer), one type of long sleeved
jumper (mid-layer), one type of coat (top layer) and
a pair of trainers.
Since the F1 races take place over 10 different
months of the year, and all over the world, the
weather and temperatures at the different circuits
can vary hugely. For example, Bahrain is one of
the hottest locations and can reach high
temperatures of around 40C, but in Montreal it can
be as low as 5C.
See if you can come up with a team kit option
which includes a base, mid and top layer as well as
a pair of trainers. Think carefully about making sure
that they will have the option of keeping cool and
warm with the choices you make.
Once you have tried out some different options, put
your final choices in the table below. If you can, fill
in the ‘reason’ box underneath to explain why
you’ve made those choices. 

TEAM KIT COSTS: 



Final Team Kit choice:

Layers Clothing choice Cost per item Total cost for 50 

Example Base layer Thick polo shirt £10 £500

Base layer 

Mid-layer 

Top Layer 

Footwear

Total cost for all 4 items of team kit for 50 members of staff: _________________

Reasoning:
I chose the combination of clothing and footwear because
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________


